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TpH // General information

1 General information
1.1 Introduction
Welcome to TriOS.

We are pleased that you have chosen our pH sensor TpH.

The TpH is based on the electrochemical measuring method with a measuring electrode and a reference
electrode. Calibrations made are stored internally by this intelligent sensor. This enables a “plug-and-play”
system without recalibration when changing the location or transmitter.

In this manual you will find all the information you need for commissioning the TpH. Technical specifications
as well as detection limits and dimensions can be found in chapter 7.

Please note that the user is responsible for complying with regional and national regulations for the installa-
tion of electronic devices. Any damage caused by incorrect use or unprofessional installation is not covered
by the warranty.

All sensors and accessories supplied by TriOS Mess- und Datentechnik GmbH must be installed and oper-
ated in accordance with TriOS Mess- und Datentechnik GmbH specifications. All parts have been designed
and tested according to international standards for electronic instruments. The device complies with interna-
tional standards for electromagnetic compatibility. Please use only original TriOS accessories and cables to
ensure smooth and professional use of the devices.

Read this manual carefully before using the device and keep it for future reference. Before using the sensor,
make sure that you have read and understood the safety precautions described below. Always ensure that
the sensor is operated correctly. The safety precautions described on the following pages are intended to en-
sure problem-free and correct operation of the device and the associated accessories and to prevent you,
other persons or devices from being harmed.

NOTICE
If translations differ from the original German text, the German version is binding.

Firmware updates

This manual refers to firmware version 1.0.1. and higher. Updates include troubleshooting and new functions
and options. Devices with older firmware versions may not have all the functions described here.

Copyright notice

All contents of this manual, in particular texts, photographs and graphics, are protected by copyright. Unless
expressly indicated otherwise, the copyright lies with TriOS Mess- und Datentechnik GmbH. Persons who vi-
olate the copyright are liable to prosecution in accordance with § 106 ff of the Copyright Act and will also be
warned and liable to pay compensation.
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1.2 Health and safety instructions
This manual contains important information on health and safety regulations. This information is marked in
accordance with the international specifications of ANSI Z535.6 (“Product safety information in product man-
uals, instructions and other collateral materials”) and must be followed. The following categories are distin-
guished:

DANGER
Danger / Will cause serious injury or death

WARNING
Warnings / May cause serious injury or death

CAUTION
Caution / May cause moderate injury

NOTICE
May lead to material damage

Tip / Useful information

Electromagnetic waves

Devices that emit strong electromagnetic waves can influence the measurement data or cause the sensor to
malfunction. Avoid operating the following devices in the same room as the TriOS sensor: cell phones, cord-
less phones, transceivers or other electrical devices that generate electromagnetic waves.

Reagents

Follow the manufacturer's safety and operating instructions when using reagents. Observe the applicable
Hazardous Substances Ordinance for reagents (GefStoffV)!

Biological safety

Liquid waste may be biologically hazardous. You should therefore always wear gloves when handling such
materials. Observe the currently valid Biological Substances Ordinance (BioStoffV)!

Waste

When handling liquid waste, the regulations for water pollution, drainage and waste disposal must be ob-
served.

G
en

er
al

 in
fo

rm
at

io
n

In
tr

od
uc

tio
n

C
om

m
is

si
on

in
g

A
pp

lic
at

io
n

C
al

ib
ra

tio
n

M
al

fu
nc

tio
n 

an
d

m
ai

nt
en

an
ce

Te
ch

ni
ca

l d
at

a
A

cc
es

so
rie

s
W

ar
ra

nt
y

Te
ch

ni
ca

l s
up

po
rt

C
on

ta
ct

 u
s

In
de

x
A

pp
en

di
x

D01-068en202604 TpH Manual 5



TpH // General information

1.3 Warning notices
General notices:

• This sensor has been developed for use in industry and science. It should only be used to measure aque-
ous solutions such as process waste water, river water or seawater.

• The material resistance should be tested for each application.
• Do not cut, damage or modify the cable. Ensure that there are no heavy objects on the cable and that the

cable does not kink. Ensure that the cable does not run close to hot surfaces.
• If the sensor cable is damaged, it must be replaced with an original part by TriOS Mess- und Datentech-

nik GmbH customer support.
• Plug the sensor if it becomes excessively hot (i.e. more than lukewarm). Switch off the sensor immediate-

ly and disconnect the cable from the power supply. Please contact your dealer or TriOS technical support.
• Never attempt to disassemble or modify any part of the sensor unless specifically described in the manu-

al. Inspections, modifications and repairs may only be carried out by the device dealer or by TriOS autho-
rized and qualified specialists.

• Devices from TriOS Mess- und Datentechnik GmbH comply with the highest safety standards. Repairs to
the devices (which include the replacement of the connecting cable) must be carried out by TriOS Mess-
und Datentechnik GmbH or an authorized TriOS workshop. Incorrect, improper repairs can lead to acci-
dents and injuries.

NOTICE
TriOS does not assume any warranty for the plausibility of the measured values. The user is al-
ways responsible for monitoring and interpreting the measured values.

1.4 User and operating requirements
The TpH sensor was developed for use in industry and science. The target group for operating the TpH is
technically experienced specialist personnel in companies, sewage treatment plants, waterworks and insti-
tutes.

The application often requires the handling of hazardous substances. We assume that the operating person-
nel are familiar with the handling of hazardous substances due to their professional training and experience.
In particular, the operating personnel must be able to correctly understand and implement the safety mark-
ings and safety instructions on the packaging and in the package inserts of the test kits.

1.5 Intended use
The intended use of the TpH is exclusively to carry out measurements of pH values in aqueous solutions as
described in this manual. In this respect, the TpH is an immersion sensor that is used under water or in con-
junction with flow cells. Please observe the technical data of the accessories. Any other use is considered
improper.

The compact and robust sensor is particularly suitable for the following areas of application:

• Industrial and municipal sewage treatment plants
• Waste water management
• Monitoring of surface waters
• Aquaculture and fish farming
• Drinking water monitoring

Use in other media may damage the sensor. To use the TpH in media other than those specified here,
please contact TriOS Mess- und Datentechnik GmbH support (support@trios.de).

According to current scientific knowledge, the device is safe to use if it is handled in accordance with the in-
structions in this manual.
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TpH // General information

NOTICE
Damage caused by improper use is excluded from the warranty.

1.6 Disposal instructions
At the end of its service life or useful life, the device and its accessories can be returned to the manufacturer
(see address below) for disposal  in an environmentally friendly manner. Proof of prior professional decont-
amination must be provided in the form of a certificate. Please contact us before returning the device for fur-
ther details.

Address of the manufacturer:

TriOS Mess- und Datentechnik GmbH
Bürgermeister-Brötje-Str. 25
26180 Rastede
Rastede, Germany
Phone: +49 (0) 4402 69670 - 0
Fax: +49 (0) 4402 69670 - 20

1.7 Certificates and approvals
The product meets all requirements of the harmonized European standards. It therefore fulfills the legal re-
quirements of the EU directives. TriOS Mess- und Datentechnik GmbH confirms the successful testing of the
product by affixing the CE mark (see appendix).
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TpH // Introduction

2 Introduction
2.1 Introduction
The TpH is based on the electrochemical measuring method with a measuring electrode and a reference
electrode. Calibrations are stored internally by this intelligent sensor. This enables a “plug-and-play” system
without recalibration when changing the location or transmitter.

Reliability through integrated encapsulated preamplifier

The encapsulated design protects the sensor's integrated preamplifier from moisture and humidity to ensure
that the sensor works reliably. The preamplifier generates a strong signal so that the sensor can be located
up to 300 m away from the controller.

2.2 Product identification
All TriOS Mess- und Datentechnik GmbH products are provided with a product label that clearly shows the
product designation.

There is also a type plate on the device with the following information, which you can use to clearly identify
the product:

TpH

Serial number
Product type

Power supply
Interface

The nameplate also contains the product barcode, the TriOS Optical Sensors logo and the CE quality mark.

Please note that the specifications given here are for illustrative purposes only and may vary depending on
the product version.

2.3 Scope of delivery
The delivery includes the following components:

■ Sensor
■ Manual/Short Instruction
■ Accessories (if applicable)

Keep the original packaging of the device for possible return shipment for maintenance or repair purposes.

8 D01-068en202604 TpH Manual



TpH // Introduction

2.4 Measurement principle and structure
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3 Commissioning

This chapter covers the commissioning of the sensor. Pay particular attention to this section and follow the
safety precautions to protect the sensor from damage and yourself from injury.

Before putting the sensor into operation, make sure that it is securely fastened and that all connections are
made correctly.

3.1 Electrical installation
The sensor is supplied with a fixed cable with an M12 industrial plug.

NOTICE
The sensor can be operated with 12 – 24 VDC.

3.1.1 Fixed cable with M12 industrial plug

1. RS-485 A (commands)
2. RS-485 B (data)
3. do not connect
4. do not connect
5. do not connect
6. do not connect
7. ground (power + serial interface)
8. power (12 - 24 VDC)

The sensor is ready for commissioning as soon as the mounting of accessories has been completed, it has
been connected to your control device and the configuration has been completed.

NOTICE
Ensure that the polarity of the operating voltage is correct, otherwise the sensor may be damaged.

3.2 Interfaces
3.2.1 Serial interface

The serial interface of the sensor is RS-485 (9600/8-N-1).

With RS-485, voltages from -5 V to +5 V with respect to ground are possible. RS-485 uses a differential sig-
nal, whereby the sign-negated potential of the A line is applied to the B line. The decisive factor is the differ-
ence A-B, which makes the transmission as robust as possible against interference signals.

The protocol used is Modbus RTU. A detailed description of the Modbus RTU protocol for the sensor can be
found in the appendix.
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TpH // Application

4 Application

The TpH sensor can be operated with all TriOS controllers. You will find notices for correct installation in the
respective controller manual. The sensor is automatically recognized on all TriOS controllers during the sen-
sor scan after the controller is switched on.

4.1 Normal operation
The sensor is ready for commissioning as soon as the mounting of accessories has been completed, it is
connected to your control unit and the configuration has been completed.

Remove the black protective cap by holding the sensor vertically downwards and unscrewing the cap. The
sensor is supplied with the protective cap filled with a solution of pH4 buffer and potassium chloride. There-
fore, the sensor does not need to be activated to achieve optimal readings. Please note the minimum immer-
sion depth up to the ring.

NOTICE
If the sensor is dry, it must first be conditioned in pH4 buffer for 24 hours.

The sensor is now immersed in the measuring medium. The black sensor head should be completely sur-
rounded by the medium. Otherwise, measurement fluctuations may occur.

To take a measurement, all air bubbles under the membrane must first be removed by gently shaking the
sensor.

As soon as the sensor is connected to the power supply, it starts measuring. This can be recognized optical-
ly by the green glow in the upper sensor area. To obtain stable and safe measured values, please wait for
the temperature to stabilize after inserting the sensor into the measuring environment.

The TpH sensor should be calibrated at regular intervals. The intervals depend on the respective application.
If the TpH measures in the strongly alkaline range, the calibration intervals should be as short as possible.
Information on calibration can be found in chapter 5.

The TpH are considered consumables and therefore have a limited service life, depending on the user's ap-
plication. Under normal conditions, a typical service life would be about one year. The service life of the TpH
can be extended by regular cleaning.

4.2 Bypass installation
To integrate the sensor into a bypass installation, there is a suitable TriOS flow cell. This is designed accord-
ing to a modular system and allows the system to be adapted or expanded as required.
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TpH // Application

Installation in the FlowCell

Follow the steps in the following instructions to install the TpH in the TriOS FlowCell.

1. Remove the pressure ring from the FlowCell. It can easily be opened by hand.
2. In the next step, slide the o-ring (attached to the FlowCell in a bag) onto the TpH. Then insert the TpH

into the FlowCell.
3. When the TpH is positioned, run the pressure ring along the cable above the sensor to fix it on the Flow-

Cell.
4. When the TpH has been positioned correctly, tighten the pressure ring hand-tight.

4.3 Support tube installation
TriOS offers two adapter pieces for the TpH sensor for installation in existing pipe systems:

• NPT1 adapter ZM46 (incl. lock nut ZM13)
• G1 adapter ZM41 (incl. lock nut ZM13)

Assembly diagram

1. Feed the sensor cable through the adapter from the side onto which the screw cap will later be screwed
(short thread).

2. Pull the complete cable through and push the sensor into the adapter as far as it will go (up to the guide
obstacle).

3. Secure the sensor with the fastening cap.
4. The sensor and adapter can now be installed in the holder tube.

4.4 Storage
Never store the sensor in a dry place. Always keep the protective cap and reuse it for storage in a solution of
pH4 buffer and potassium chloride or a 3 molar KCl solution.

NOTICE
Never store the TpH sensor dry.
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TpH // Application

If a sensor or the electrode of the sensor does fall dry, the swelling layer on the electrode must be re-formed.
To do this, the sensor must be immersed in a 3 molar KCl solution for several hours (> 12 h).

NOTICE
Never store the TpH sensor in distilled water!
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TpH // Calibration

5 Calibration

TpH sensors that have not been used for a long time or new sensors should be calibrated before measure-
ment. The calibration should also be repeated at regular intervals. The intervals between calibrations de-
pend on the type of application (strongly fluctuating pH values, abrasive measuring medium or deposits that
build up on the measuring electrodes). Tests with standard solutions are recommended to determine the in-
tervals. TriOS offers suitably filled buffer solutions pH4 and pH7 (see chapter 8). The frequency of calibration
depends on experience. For newly installed systems, hourly testing and calibration may be necessary. If you
notice stable values, the calibration interval can be increased.

Calibration is possible both on the controllers (see chapter 8) and via Modbus. Calibrations carried out are
stored internally by this intelligent sensor. This means that the current calibration is always available.

5.1 pH calibration

Calibration is used to calibrate the zero value (pH7) and the scaling factor (pH4 or pH10, depending on the
application). For calibration, select pH buffer solutions with an accuracy of ± 0.01 pH and observe the tem-
perature. Fresh or newly prepared solutions must be used for each calibration! TriOS offers a set of pH
buffer solutions ideally matched to the TpH with sensor holder for 6 calibrations.

Buffer solution pH4
6 x 25 mL

Buffer solution pH7
6 x 25 mL

Procedure:

• Since the pH value is temperature-dependent, it is recommended to check the temperature with a refer-
ence thermometer before the first pH calibration.

• If the temperature measured with the sensor deviates more than 1 °C from the temperature measured
with a reference thermometer, a calibration of the temperature offset is necessary (see 6.2).

• Rinse the sensor with distilled water.

NOTICE
The electrode must not be wiped off.

pH7 calibration

• Immerse the TpH in pH7 buffer solution; the sensor head (black) should be as completely immersed as
possible (see illustrations below). Otherwise, measurement fluctuations may occur.

• Slowly immerse the sensor in the beaker and move it slightly back and forth so that the membrane is wet-
ted with the buffer solution.

• Allow the sensor to warm up for as long as possible until the measured values have stabilized (at least 5
minutes) and then calibrate to pH7. Pay attention to the temperature!
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TpH // Calibration

NOTICE
Do not stir the sensor in the buffer solution!

NOTICE
The pH value is temperature-dependent!

pH4 or pH10 calibration

• Rinse the sensor again with distilled water.
• Immerse the TpH in pH4 buffer solution (or pH10 buffer solution, if necessary). The sensor head (black)

should be completely immersed. Otherwise, measurement fluctuations may occur.
• Allow the sensor to warm up for as long as possible until the measured values have stabilized (at least 5

minutes) and then calibrate to pH4 (or pH10). Pay attention to the temperature!
• Rinse the sensor again with distilled water.
• You can now start your measurements.
• Dispose the buffer solutions after use.

5.2 Measurement properties
Influences on the measurement

The pH measurement depends on the following parameters:

• The temperature of the measuring medium also has an influence on the ageing of the electrode.
• Observe the immersion depth: an immersion depth that is too shallow can lead to fluctuating measured

values.
• Air bubbles on the sensor can cause measurement errors.
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• Alkali error: at pH values above pH12, alkali ions (Li+, Na+) can cause lower pH values to be displayed,
as the alkali ions are detected in addition to the H+ ions.

• Flow can influence the measured value.

Temperature compensation

Temperature compensation is performed automatically by the integrated temperature sensor (Pt1000).

16 D01-068en202604 TpH Manual
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6 Malfunction and maintenance
6.1 Cleaning and care
The sensor requires only minimal maintenance. In applications that cause heavy soiling on the sensor, the
sensor should be serviced more often.

NOTICE
Do not disassemble the sensor for cleaning and maintenance purposes.

• The sensor should always be kept clean. If there is a biofilm on the sensor, this can lead to measurement
errors.

• A dirty sensor should be cleaned with buffer solution.
• If possible, mechanical impact on the glass membrane should be avoided.
• For stubborn soiling, a very soft brush or a soft sponge can be used carefully.
• For more solid deposits, the sensor can be immersed in a diluted HCl solution or a base. In the case of

organic deposits, pepsin can also be used.

NOTICE
Always rinse the sensor and the sensor system carefully with distilled water after cleaning.

If the sensor is taken out of service, it should be stored cleaned. The protective cap must be filled with a
3 molar KCl solution.

NOTICE
Damage caused by improper cleaning is not covered by the warranty!

6.2 Maintenance and testing

NOTICE
Avoid touching the sensor as this could damage it. If this is the case, the functionality of the sen-
sor can no longer be guaranteed.

The average service life of a TpH sensor is about 1 year. If difficulties occur during calibration, the sensor will
probably need to be replaced.

Temperature calibration

As the pH value is temperature-dependent, it is recommended to check the temperature of the buffer solu-
tion with an accurate reference thermometer before pH calibration. If the temperature measured by the sen-
sor deviates more than 1°C from the one measured by the reference thermometer, a calibration of the tem-
perature offset is necessary.

1. Set the controller to “Maintenance mode” / “Service mode” under Options.
2. Select the TpH sensor under “Sensors” and the corresponding connection (COM port).
3. Press the “Calibrate” button and select the temperature.
4. The following calibration wizard will guide you through the next steps:

G
en

er
al

 in
fo

rm
at

io
n

In
tr

od
uc

tio
n

C
om

m
is

si
on

in
g

A
pp

lic
at

io
n

C
al

ib
ra

tio
n

M
al

fu
nc

tio
n 

an
d

m
ai

nt
en

an
ce

Te
ch

ni
ca

l d
at

a
A

cc
es

so
rie

s
W

ar
ra

nt
y

Te
ch

ni
ca

l s
up

po
rt

C
on

ta
ct

 u
s

In
de

x
A

pp
en

di
x

D01-068en202604 TpH Manual 17



TpH // Malfunction and maintenance

■ Enter the measured temperature (reference thermometer) as the target value and press the “Next”
button.

■ Then initiate a measurement by pressing the “Measurement” button.
■ Wait until the “Next” button is active and press it.

5. At the end, you will be asked whether you want to save the calibration. The new calibration is saved in
the sensor by pressing the “Next” button; the previous calibration is restored by pressing “Cancel”.

Replacing the sensor

NOTICE
If the sensor is replaced, the controller settings must be reconfigured for the new sensor.

1. If you need to replace your sensor with a new one, you should set your TriBox3 to maintenance mode:
“Options” ► “Maintenance mode”.

2. Remove the sensor from the FlowCell / from the pipe. At this point, you should also check whether the
O-rings are still in good condition. Replace the O-rings if necessary.

3. Configuration of the new sensor:

Connect the new sensor to the TriBox3. Press “Sensor Scan”. After a short time, the TriBox3 should
have recognized the sensor.

Display:
“Display” ► Select the window ► Select the window(s) to be changed for the TpH ►“Current value” ►
Select the measured value to be displayed.

Automatic measurements:
Select the TpH sensor in the “Sensor” menu (blue field).

Select “Automatic measurement” ► “Automatic measurement” or “Burst mode” (as required ).

To set the automatic measurements (if “Burst mode” has not been selected), go to “Options” ► “Auto-
matic measurements” ► “Raster” ► Select the measurement interval from the drop-down menu as re-
quired.

Set Modbus address:
“Sensor” menu ► press TpH sensor button ► “Modbus server settings” ►“Slave address” ► set the ad-
dress required for your system.

Analog outputs:
“Options” ► “Analog outputs” ► select the analog output on which the previous TpH sensor was set ►
“measured value used” ►select the new sensor from the drop down menu ►set scaling information.

Post-processing:
If you want to retain the previous post-processing settings, you can do this via “Sensor” ►“pH”. Here
you can configure the sensor settings as required.

6.3 Return shipment
Please note the procedure for your return shipment.
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If you are returning a sensor or device, please use the URL trios.de/rma to go to our online form, which
you can use to register your return shipment to TriOS technical support.

To ensure a smooth return shipment process, please fill out the online form completely. Please note the
mandatory fields, otherwise the form cannot be sent. The system automatically assigns an RMA number.

After submitting your entries, you will immediately receive an e-mail with the data you have entered, a link to
free DHL shipping and a label with the RMA number of your case.

Please make sure you stick this label clearly visible on the outside of your return package so that the
package can be assigned more quickly.

Please note! Return shipments without an RMA number cannot be accepted and processed!

Please note that sensors or devices may need to be cleaned and disinfected before shipping.

In order to ship the goods undamaged, use the original packaging. If this is not available, ensure that safe
transportation is guaranteed and that the sensors are secured with sufficient packing material.

We will contact you as soon as possible after receipt of the return shipment.
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7 Technical data
7.1 Technical specifications
TpH

Measurement technology pH electrode

Measurement principle Potentiometry

Parameters pH value, temperature

pH 0...14 pHMeasurement
range Temperature 0...+65 °C ~ +32 to +149 °F

pH 0.01 pH
pH resolution

Temperature 0,1 °C ~ +32.2 °F

pH ± 0.06 pHMeasurement
accuracy temperature ± 0,5 °C ± +32.9 °F

pH1 ± 0.05 pH

pH7 ± 0.05 pHIntrinsic
deviation

pH13 ± 0.35 pH

Linearity measurement error ± 0.1 pH

pH1 ± 0.1 pH

pH7 ± 0.05 pHRepeatability

pH13 ± 0.1 pH

pH7 ± 0.025 pHOutput signal
fluctuation pH4 ± 0.05 pH

Warm-up time < 5 min

Short-term drift
24 h

≤ 0.03 pH

Drift
Long-term drift
1 week

≤ 0.05 pH

T10 ascending < 2 s

T10 falling < 2 s
10 % time
and
90 % time

T90 ascending ≤ 5 s
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T90 falling ≤ 5 s

Temperature compensation Pt1000

Measurement interval 2 s

Housing material PPS / PET / NBR

Dimensions (L x Ø) ~ 180 x 27 mm ~ 7.1˝ x 1.1˝

Weight 110 g ~ 0.2 lbs

Interface RS-485, Modbus RTU

Power consumption 0.2 W

Power supply 12 - 24 VDC (± 10 %)

Connection 8pin M12 plug

Sensor cable 2 m and 10 m

Maintenance effort ≤ 0.5 h/month typical

Calibration /
maintenance interval Typically, 4 weeks

System compatibility Modbus RTU

Warranty 1 year (EU & USA 2 years) on electronics; wearing parts are exclud-
ed from the warranty

with fixed cable 3 bar ~ 43.5 psiMax. pres-
sure in FlowCell 1 bar, 2...4 L/min ~ 14.5 psi, 0.5 to 1 gpm

Degree of protection IP68

Sample temperature +2...+40 °C ~ +36 to +104 °F

Ambient temperature -5...+55 °C ~ +23 to +131 °F

Storage temperature 0...+40 °C* ~ +32 to +176 °F

Inflow velocity 0...3 m/s ~ 0 to 10 fps

Recommendation from TriOS: Storage at +5...+15 °C (+41 to +59 °F) for longer shelf life
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7.2 Outer dimensions
11

22

33

44

55

66

A
A

B
B

C
C

D
D

Name: TpH
Date: 23.02.2018 Rev.: TP101711
Note: Dimensions in mm
 Document: D10-068en201805

TriOS Mess- und Datentechnik GmbH 
●

 Bgm.-Brötje-Str. 25 
● 26180 Rastede 

● Germany
fon: +49 4402 / 69 67 0 - 0 

●
 fax: - 20 

●
 web: http://www.trios.de 

●
 e-mail: info@

trios.de

D
i
m

e
n
s
i
o
n
 
D

r
a
w

i
n
g
:
 
T

p
H

Weitergabe sowie Vervielfältigung dieses Dokuments, Verwertung und Mitteilung seines Inhalts sind verboten,

soweit nicht ausdrücklich gestattet. Zuwiderhandlungen verpflichten zu Schadenersatz. Alle Rechte vorbehalten.

The reproduction, distribution and utilization of this document as well as the communication of its contents to others

without express authorization is prohibited. Offenders will be held liable for the payment of damages. All rights reserved.

Page 1  of 1 

Note: iProperty -> Übersicht -> Kommentar
Preliminary: iProperty -> Status -> Status 
Titel: iProperty -> Übersicht -> Titel 

23~

27~

138
~

36,5
~

AF = across flats

178
~

Position
Material

sensor body
Polyethylene Terephthalate (PET)
Polyphenylene Sulfide (PPS)

sealings
Nitrile Butadiene Rubber (NBR)

pH Stem
pH Sensing Glass
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8 Accessories
8.1 TriBox3
TriBox3 is a measuring and control system for all
TriOS sensors. The device offers 4 sensor chan-
nels with selectable RS-232 or RS-485 function.
In addition to Modbus RTU, various other proto-
cols are available.
A built-in valve allows the use of compressed-air
cleaning for the sensors. The TriBox3 also offers
various interfaces, including an IEEE 802.3 Eth-
ernet interface, a USB port and 6 analog outputs
(4 .. 20 mA).
An integrated relay can be used to trigger alarms
or control external devices. Low power con-
sumption, a robust aluminum housing and a
range of interfaces makes it suitable for all appli-
cations in environmental monitoring, drinking wa-
ter, wastewater treatment plants and many other
areas.

8.2 TriBox mini
Digital 2-channel controller

Die TriBox mini is an controller with two digital
sensor inputs and two 4 .. 20 mA outputs and
represent a cost-effective alternative to analog
measuring points.
The TriBox mini is compatible with all TriOS sen-
sors.
All stored measured values and diagnostic data
can be read out via an integrated web browser.

8.3 Flow cell
Flow cell for eCHEM sensors

The flow cells specially developed for the
eCHEM series are used for bypass installations
of the eCHEM sensors manufactured by TriOS.

The measuring medium is fed through the cell
via an inflow, thus enabling reagent-free mea-
surement outside the process.

The flow cells are based on a modular system
that can be expanded with additional modules.
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8.4 pH buffer set
The pH buffer set contains 6 x pH 4 and 6 x pH 7
liquid standards, which are used for calibration of
the TriOS sensors. This ensures reliable detection
of the pH value.
Together with the sensor holder and the FlowCell,
it also allows you to carry out a quick and precise
check of our TriOS pH sensors on site.

pH values of the TriOS buffer solution as a function of temperature
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9 Warranty

The warranty period for our devices within the EU and the USA is 2 years from the date of invoice. Outside
the EU it is 1 year. Excluded from the warranty are all normal consumables
(depending on the product, e.g. light sources or windows).

The warranty is subject to the following conditions:

• The device and all accessories must be installed as described in the relevant manual and operated in ac-
cordance with the specifications.

• Damage caused by contact with aggressive and material-damaging substances, liquids or gases, as well
as transport damage, are not covered by the warranty.

• Damage caused by improper handling and use of the device is not covered by the warranty.
• Damage caused by modification or unprofessional attachment of accessories by the customer is not cov-

ered by the warranty.

NOTICE
Opening the device will void the warranty!
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10 Technical support

If you have a problem with a TriOS sensor / a TriOS device, please contact TriOS technical support.

We recommend sending in sensors every 2 years for maintenance and calibration. When returning devices,
please be sure to follow the procedure described in Chapter 6.

Contact technical support:

E-mail: support@trios.de
Phone: +49 (0) 4402 69670 - 0
Fax: +49 (0) 4402 69670 - 20

To enable us to help you quickly, please send us the sensor ID number (serial number with 8 digits, consist-
ing of letters and numbers, e.g. 6700003F) by e-mail.
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11 Contact us

We are constantly working on improving our devices. Please visit our website for the latest news.

If you have found a fault in one of our devices or programs or would like additional functions, please contact
us:

Technical Support: support@trios.de
General questions/sales: sales@trios.de
Website: www.trios.de

TriOS Mess- und Datentechnik GmbH
Bürgermeister-Brötje-Str. 25
26180 Rastede
Rastede, Germany
Telephone +49 (0) 4402 69670 - 0
Fax +49 (0) 4402 69670 - 20
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S

Scope of delivery.........................................................................................................................................................................................  8
Storage.......................................................................................................................................................................................................  12
Support pipe installation............................................................................................................................................................................  12
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Technical support................................................................................................................................................................................  26, 27
type plate.....................................................................................................................................................................................................  8
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13 Appendix
13.1 CE declaration of conformity

 

D05-068yy202405 
Seite 1 von 1 

 

 

 

 
Hersteller/Manufacturer/Fabricant: TriOS Mess- und Datentechnik GmbH 

Bürgermeister-Brötje-Str. 25 
D- 26180 Rastede 

 

Konformitätserklärung 
Declaration of Conformity 
Déclaration de Conformité 

 
Die TriOS GmbH bescheinigt die Konformität für das Produkt 
The TriOS GmbH herewith declares conformity of the product 
TriOS GmbH déclare la conformité du produit 
 
Bezeichnung 
Product name 
Désignation 

TpH 

  
Typ / Type / Type pH Art.Nr. 80S1000x0 

 
  
Mit den folgenden Bestimmungen 
With applicable regulations 
Avec les directives suivantes 

2014/30/EU EMV-Richtlinie 
2011/65/EU RoHS-Richtlinie 
+ (EU) 2015/863 
+ (EU) 2017/2102 
 

  
Angewendete harmonisierte Normen 
Harmonized standards applied 
Normes harmonisées utilisées 

EN IEC 61326-1:2021 
EN 61010-1:2010 +A1:2019 
+A1:2019/AC:2019 
EN IEC 63000:2018 
 

  
Datum / Date / Date Unterschrift / Signature / Signature 
  
23.05.2024 

 
R. Heuermann 
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13.2 Modbus RTU
Firmware version

This Modbus protocol refers to firmware version 1.0.x and higher

Serial interface

On delivery, the serial interface is configured with the following settings:

• Baud rate: 9600 bps
• Data bits: 8
• Stop bits: 1
• Parity: none

Data types

Data type name register format

Bool 1 false: 0x0000, true: 0xFF00

Uint8 1 8-bit positive integer. Values: 0x0000 - 0x00FF

Uint16 1 16-bit positive integer. Values: 0x0000 - 0xFFFF

Uint32 2 32-bit positive integer. Values: 0x00000000 - 0xFFFFFFFFFF

Float 2 IEEE 754 32-bit floating point number

Char[n] Zero terminated ASCII character string consisting of n characters

Uint16[n] n Field of n 16-bit integers (cf. Uint16)

Float[n] 2n Field of n floating point numbers (cf. Float)

Functions

The sensor supports the following Modbus functions:

Name Code Description / Use

Read multiple
registers

0x03 Read serial number, configuration, calibration and measurement data

Write multiple 
registers

0x10 Write configuration and calibration

Write single 
register

0x06 Write configuration and calibration

Report slave ID 0x11 Read serial number and firmware version

Standard Modbus server address

On delivery, the sensor is set to address 20 (0x14).
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Access restrictions

The R/W column describes the access restrictions for the registers. “R” can be read (0x03), “W” can be writ-
ten (0x10).

Letter Letter Description

R Read access only

R/W Read and write access

Read / Write multiple registers (0x03 / 0x10)

The registers contain the following values:

Designation R/W Address Data
type

Data type Description

Modbus slave ID R/W 0 Uint16 The Modbus server address of the sensor.

Measurement time-
out

R 1 Uint16
The time in [10-1 s] that the currently active measurement
process will continue

Serial Setting - baud
rate

R/W 2 Uint16

- 0x0000: 9600 baud
- 0x0001: 19200 baud 
- 0x0002: 38400 baud
- 0x0003: 56700 baud

Serial Setting - Parity R/W 3 Uint16
- 0x0000: None
- 0x0001: Odd
- 0x0002: Even

Serial Setting - Stop-
bits

R/W 4 Uint16
- 0x0001: 1 stop bit 
- 0x0002: 2 stop bits

Device serial number R 10 Char[20] The serial number of the TpH sensor

Firmware version R 15 Char[20] The version number of the installed firmware

System date and
time

R/W 107 Uint32 The current time in seconds since 01.01.1970. (Internal
counter with ±0.9% accuracy @ 8.00MHz)

Device description R/W 109 Char[64] A free description of the sensor. E.g.: “southern inlet pipe”

Index for Moving Av-
erage / Offset / Scal-
ing

R/W 400 Uint16

The index of the parameter for the following offset and scal-
ing settings. The index is based on the parameter list in this
description from register 1000: 
- 0x0000: pH 
- 0x0001: Temperature

Moving average R/W 401 Uint16

The number of measurements over which a moving aver-
age is calculated. 

Value range: 1 - 25 
Default value: 10
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Designation R/W Address Data
type

Data type Description

Offset R/W 402 Float
Offset parameter.
Formula: scaled = (raw - offset) * scaling

Scaling R/W 404 Float
Parameter Scaling factor.
Formula: scaled = (raw - offset) * scaling

pH R 1000 Float pH value of the medium (original value)

Temperature R 1002 Float The temperature of the medium in °C (original value)

SQI R 1004 Float Sensor quality index

pH scaled R 1500 Float The pH value of the medium (customer scaled)

Temperature scaled R 1502 Float The temperature of the medium in °C (customer scaled)

FSM Control R/W 5000 Uint16 FSM control register (calibration).

FSM Parameter R/W 5001 Uint16

FSM parameter register (calibration), contains parameter in-
dex and calibration method.

- 0x0001: pH 
- 0x0103: Temperature

FSM status R 5002 Uint16 FSM status register (calibration)

Permanent errors R 5100 Uint16 Permanent errors (bit field)

Permanent warnings R 5101 Uint16 Permanent warnings (bit field)

Temporary errors R 5102 Uint16 Temporary errors (bit field)

Temporary warnings R 5103 Uint16 Temporary warnings (bit field)

Calibration control R/W 6000 Uint16

Calibration control register, for complete restoration of the
calibration (pH and temperature): 

0x0001: Factory calibration 
0x0002: Last calibration

Factory calibration
parameter

R/W 6001 Uint16

Parameter index of the following calibration data (factory
calibration):

- 0x0000: pH 
- 0x0001: Temperature

Factory calibration -
Offset

R/W 6002 Float Offset of the factory calibration for the selected parameter

Factory calibration -
Scaling

R/W 6004 Float
Scaling factor of the factory calibration for the selected pa-
rameter

Factory calibration -
Square

R/W 6006 Float
Square coefficient of the factory calibration for the selected
parameter
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Designation R/W Address Data
type

Data type Description

Not used, always 0

Factory calibration -
Timestamp

R/W 6008 Uint32 Time of the factory calibration

Active calibration -
Parameter

R/W 6010 Uint16

Parameter index of the following calibration data (active cal-
ibration):

- 0x0000: pH 
- 0x0001: Temperature

Active calibration -
Offset

R/W 6011 Float Offset of the active calibration for the selected parameter

Active calibration -
Scaling

R/W 6013 Float
Scaling factor of the active calibration for the selected para-
meter

Active calibration -
Square

R/W 6015 Float

Square coefficient of the active calibration for the selected
parameter

Not used, always 0

Active calibration -
Timestamp

R/W 6017 Uint32 Time of the active calibration.

Last calibration - pa-
rameter

R/W 6019 Uint16

Parameter index of the following calibration data (last cali-
bration):

- 0x0000: pH 
- 0x0001: Temperature

Last calibration - Off-
set

R/W 6020 Float Offset of the last calibration.

Last calibration -
Scaling

R/W 6022 Float
Scaling factor of the last calibration for the selected para-
meter

Last calibration -
Square

R/W 6024 Float

Square coefficient of the last calibration for the selected pa-
rameter

Not used, always 0

Last calibration -
Timestamp

R/W 6026 Uint32 Time of the last calibration.
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Errors and warnings

Permanent errors indicate a defect in the sensor.

Description Bit mask

General error 0x0001

ADC upper limit exceeded 0x0002

ADC lower limit exceeded 0x0004

Permanent warnings

Description Bit mask

n/a n/a

Temporary errors provide notice of the cause of questionable measured values (SQI) or calibration problems

Description n/a Bit mask

ADC error 0x0001

ADC upper limit exceeded 0x0002

ADC lower limit exceeded 0x0004

FSM invalid status 0x0010

FSM invalid transition 0x0020

FSM insufficient authentication 0x0040

FSM invalid parameter index 0x0100

FSM invalid calibration method 0x0200

Temporary warnings give notice of the cause of questionable measured values (SQI)

Description Bit mask

Temperature outside 0...+ 65 °C 0x0002

pH value outside 0.5...12.5 0x0008

Reference voltage outside 0.3...1.17 V 0x0010

Report slave ID (0x11)

Returns the sensor designation, followed by the serial number, followed by the firmware version, each as a
zero-terminated ASCII character string.

Example:

T R I O S 0x0 T p H 0x0 0 6 8 0 0 0 0 0 0x00 1 . 0 . 1 0x0
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State machine for pH calibration

State machine number

The calibration machine has the number 1.

States

0: Activation of the state machine

The state machine is activated; the sensor exits normal operating mode.

1: Validation of parameters and calibration method

The calibration method (in the low byte) and the parameter to be calibrated (in the high byte) must be select-
ed via the FSMParam parameter register. The state machine for this parameter and this calibration method
is then initialized by changing to state 1.

If the selected calibration process is possible, the sensor switches to state 2 and deactivates the current cali-
bration coefficients for the selected parameter.

Otherwise, it remains in state 1, whereby the reason for this can be determined by reading out the error reg-
ister.

2: Idle state

The calibration machine has been successfully activated or the last action has been successfully completed.
The sensor is now waiting for further commands.
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3 and 4: Measurements

The control unit can now start the measurements required for this calibration method by switching to states 3
or 4. Regardless of the calibration method, state 3 is always used for the first measuring point, etc.

6: Performing measurement

After the control unit has informed the sensor to start the measurement by changing to state 3 or 4, the sen-
sor changes to state 6 for the duration of the measurements. During this phase, the control unit should con-
tinuously trigger measurements and read out the measurement results. As soon as the sensor has collected
a sufficient number of measured values, it switches to state 7 and awaits the transfer of the setpoint value.

7: Acquisition of the target value

The control unit writes the target value into the register of the measurement parameter of the calibrated pa-
rameter. This is the same register from which the measured values of the parameter are read out. If the ter-
get value is accepted by the sensor, it acknowledges this by changing back to state 2. Otherwise, it remains
in state 7.

8: Calculation of the coefficient

Once all the required measurements have been recorded and the target values stored, the sensor can be
prompted to calculate a new calibration by switching to state 8. This new calibration is then temporarily acti-
vated and will be used to calculate the measurement values. However, this calibration is not saved yet and
will be lost if you leave the calibration machine now.

After a successful calculation, the sensor changes to state 11 (see below). If the sensor cannot calculate a
calibration, the sensor remains in state 8.

9: Save customer calibration

The customer calibration is saved by switching to state 9. This means that the previous calibration data is
marked as the last calibration and the new calibration data is marked as the active calibration. Once the cus-
tomer calibration has been saved, the parameters determined during this calibration remain active even after
leaving the calibration machine.

After successful saving, the sensor changes to state 11 (see below). In the event of an error, the sensor re-
mains in state 9.

11: Successful action

After successful calculation or saving, the sensor changes to state 11 and waits for an acknowledgement
from the control unit. The control unit needs to transmit the sensor to change to state 2.

Termination / cancellation

The state machine can be terminated at any time by setting the state control register to the value 0 and thus
switching back to normal operating mode. If the calibration has not yet been completed and the coefficients
have not been saved, the original coefficients are restored.

If error bits are set, the control unit must reset the state machine by changing to state 0. The calibration must
then be reinitialized by selecting the parameter and the calibration method.

Error states

If an error occurs during calibration and the sensor remains in one of the error states mentioned above, the
calibration machine must be terminated in any case and restarted if necessary. Error recovery within the cali-
bration machine does not take place.
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Status parameter register

The status parameter register is divided into two parts:

FSMParam

High byte Low Byte

Parameter Index Calibration method

The parameter index determines the parameter to be calibrated. The index is based on the parameter list
as shown in the measured value register area.

The calibration method is determined by one of the following values:

Calibration
method

Meaning States

0 x 00 No calibration (Reset FSM) -

0 x 01 Linear (2-point) calibration (offset, scaling) 3,4
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pH calibration

Register
5000 FSM Control
5001 FSM parameters 1 = pH

High byte LOW Byte
5002 FSM on = 1 always FSM status

Requirements
and notes Functionality

Func-
tion
code

Regis-
ter Value Length

FSM
Sta-
tus

Type Re-
sult

Step 1 pH calibration

Requirements: Activate calibra-
tion mode pH

Temperature is
calibrated

Activate calibra-
tion mode 0x06 5000 0x0100

Sensor in nor-
mal operation
(LED green)

Activate pH cali-
bration 0x06 5001 0x0001

Start calibration 0x06 5000 0x0101
Wait until sensor
LED turns blue
and FSM status 2

0x03 5002 1 2 Integer
LED
turns
blue

Step 2
Requirements: Calibrate pH 7

FSM status 2 Start pH 7 cali-
bration 0x06 5000 0x0103

Insert pH 7
buffer

Stable mea-
sured values
(query until sta-
ble)

Query register
FSM status regu-
larly until it is set
to 7 (may take a
while)

0x03 5002 1 7 Integer

Write specified
value of the stan-
dard solution

0x10 1000
IEEE
754
Float

2
IEEE
754
Float

Note:

Use 40E0 40E0
(pH7) if no floats
can be written

Query register
FSM status regu-
larly until it is set
to 2

0x03 5002 1 2 Integer
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Step 3

Requirements: Calibrate pH 10
or 4

FSM status 2 Start pH 10 or pH
4 calibration 0x06 5000 0x0104

Insert pH 10 or
pH 4 buffer
Stable mea-
sured values
(query until sta-
ble)

Query FSM sta-
tus register regu-
larly until it is set
to 7

0x03 5002 1 7 Integer

Write specified
value of the stan-
dard solution

0x10 1000
IEEE
754
Float

2
IEEE
754
Float

Note:
Use 4120 4120
(pH10) or 4080
4080 if no floats
can be written

Query register
FSM status regu-
larly until it is set
to 2

0x03 5002 1 2 Integer

Step 4

Requirements: Apply and check
calibration

Calibration was
successful

Apply calibra-
tion and wait until
FSM status is 11

0x06 5000 0x0108

FSM status 2
Query FSM sta-
tus register regu-
larly until it is set
to 11

0x03 5002 1 11 Integer

Set FSM status
back to 2 0x06 5000 0x0102

Query register
FSM status regu-
larly until it is set
to 2

0x03 5002 1 2 Integer

Note:
Query measured
values to check
whether values
are satisfactory

Query pH data 0x03 1000 2
IEEE
754
Float

The calibration has not yet been saved. 
If the calibration process is aborted between steps 1 and 6 or the power supply is switched off, the calibra-
tion is lost.
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Step 5
Requirements: Save calibration
Calibration
process was
successful

Save calibration
and wait until
FSM status is 11

0x06 5000 0x0109

Query register
FSM status regu-
larly until it is 11

0x03 5002 1 11 Integer

Set FSM status
back to 2 0x06 5000 0x0102

Query register
FSM status regu-
larly until it is set
to 2

0x03 5002 1 2 Integer

Calibration is saved

Step 6
Note: Exit calibration 0x06 5000 0x0000
If done between
steps 1 and 6,
the calibration is
lost

Query FSM sta-
tus register regu-
larly until it is set
to 0

0x03 5002 1 0 Integer
LED
turns
green
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Temperature calibration

Register
5000 FSM Control
5001 FSM parameters 259 = Temp

High byte LOW Byte
5002 FSM on = 1 always FSM status

Requirements
and notes Functionality

Func-
tion
code

Regis-
ter Value Length

FSM
Sta-
tus

Type Re-
sult

Step 1 Temperature
calibration

Requirements:
Activate temper-
ature calibration
mode

Sensor in nor-
mal operation
(LED green)

Activate calibra-
tion mode 0x06 5000 0x0100

Activate tempera-
ture calibration 0x06 5001 0x0103

Start calibration 0x06 5000 0x0101
Wait until sensor
LED turns blue
and FSM status 2

0x03 5002 1 2 Integer
LED
turns
blue

Step 2

Requirements: Calibrate temper-
ature

FSM status 2 Start calibration
Temperature 0x06 5000 0x0103

Measure refer-
ence tempera-
ture

Stable mea-
sured values
(query until sta-
ble)

Query register
FSM status regu-
larly until it is set
to 7 (may take a
while)

0x03 5002 1 7 Integer

Write reference
temperature val-
ue

0x10 1002
IEEE
754
Float

2
IEEE
754
Float

Note:

Query register
FSM status regu-
larly until it is set
to 2

0x03 5002 1 2 Integer
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Step 3

Requirements: Apply and check
calibration

Calibration was
successful

Apply calibra-
tion and wait until
FSM status is 11

0x06 5000 0x0108

FSM status 2
Query register
FSM status regu-
larly until it is 11

0x03 5002 1 11 Integer

Set FSM status
back to 2 0x06 5000 0x0102

Query register
FSM status regu-
larly until it is set
to 2

0x03 5002 1 2 Integer

Note:
Query measured
values to check
whether values
are satisfactory

Query tempera-
ture data 0x03 1002 2

IEEE
754
Float

The calibration has not yet been saved. 
If the calibration process is aborted between steps 1 and 5 or the power supply is switched off, the calibra-
tion is lost.

Step 4
Requirements: Save calibration
Calibration
process was
successful

Save calibration
and wait until
FSM status is 11

0x06 5000 0x0109

Query register
FSM status regu-
larly until it is 11

0x03 5002 1 11 Integer

Set FSM status
back to 2 0x06 5000 0x0102

Query register
FSM status regu-
larly until it is set
to 2

0x03 5002 1 2 Integer

Calibration is saved

Step 5
Note: Exit calibration 0x06 5000 0x0000
If done between
steps 1 and 5,
the calibration is
lost

Query FSM sta-
tus register regu-
larly until it is set
to 0

0x03 5002 1 0 Integer
LED
turns
green
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